
Management Science
Business Intelligence

Dan Brandon, Ph.D., PMP

http://www.google.com/url?sa=i&rct=j&q=operations+research&source=images&cd=&cad=rja&docid=zVB7LnDwfN67UM&tbnid=OWtWXXF-WTlGcM:&ved=0CAUQjRw&url=http://www.ehow.com/careers/careers/research-development-jobs/&ei=nfz3UZH2OZOE9gTtmYDABA&bvm=bv.49967636,d.aWM&psig=AFQjCNFqXF3jhy_TIDWOdsviaVATprqcBg&ust=1375292643686524


Business Intelligence

◼ As companies become larger, more complex, 
and more diverse (multinational), it becomes 
harder and harder for them to understand who 
their customers are, how to best serve them, 
and how to maximize their profits

◼ To make such decisions in todays’ fast paced 
global marketplace, companies make extensive 
use of something called “business intelligence”

◼ Data on every single aspect of a business is 
meticulously collected and then rigorously analyzed 
to make sure each action is optimal
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Business Intelligence (con’t)

◼ This approach relies on large “data 

warehouses” and complex 

software that uses sophisticated 

algorithms to pore through endless 

amounts of data

◼ Business technologists have many 

names for this revolutionary 

technology; "business intelligence” 

(BI), "data analytics," and "data 

mining" are among the most 

common
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Business Intelligence (con’t)

◼ The Economist says it's "a golden vein“, and business 

experts now call it "the new science of winning" 

◼ FedEx, Capital One, and Amazon.com can't function 

without it

◼ It's been adopted by nearly every Fortune 500 company

◼ Even professional sports franchises like the Boston Red 

Sox, Oakland A's, and New England Patriots are being 

forced to use this technology

◼ A Gartner survey of 1,400 chief information officers 

suggests that business intelligence is the number one 

technology priority for IT organizations"
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It started with Capital One...

◼ Back in the 1980s, consultants Richard Fairbank and Nigel Morris 

realized that by analyzing data, credit card companies -- like a tiny 

Virginia bank called Signet -- could systematically target the most 

lucrative customers, while leaving their competition to fight over the 

rest

◼ Their approach was so successful, Signet ended up spinning off its 

credit card division as a separate company, which became Capital 

One

◼ Today, Capital One runs approximately 300 data tests per day, and it 

credits data analysis with increasing the retention rate of its savings 

business by a whopping 87% while simultaneously slashing the cost 

of acquiring new customers by 83%

◼ BI has allowed Capital One to increase the value of its stock 1,000% 

over its first ten years as a public company -- outpacing the S&P 500 

by a power of 10
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Business Intelligence (con’t)

◼ Companies are not short on data

◼ The average large business stores 

more than 200 terabytes (1012) 

from their daily transactions

◼ This tells them who is buying 

what, and also where and when

◼ But today business also need to 

know why, or why not

◼ How have companies traditionally 

done that ?
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Business Intelligence (con’t)

◼ Traditionally this was done with 
classical business research 
such as surveys, focus groups, 
etc.

◼ But today it also comes from 
tweets, videos, likes, clickstream 
data, and other social media 
sources

◼ This is called “Big Data”

◼ The average company in 15 
of 17 US sectors now has 
more data stored than the 
Library of Congress
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Big Data Applications

◼ In addition to business applications, big data 

storage and processing requirements are also 

showing up in:

◼ Search analysis

◼ Genomes

◼ Phone records (such as the metadata analysis by 

our NSA)

◼ Video surveillance processing

◼ Geological surveys

◼ Climate data

◼ Bioinformatics, disease (i.e. cancer) simulation
Copyright Dan Brandon, PhD, PMP
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Wikipedia

◼ Business intelligence (BI) is a set of theories, 

methodologies, architectures, and technologies that 

transform raw data into meaningful and useful 

information for business purposes

◼ Making use of new opportunities and implementing an 

effective strategy can provide a competitive market 

advantage and long-term stability.

◼ Common functions of business intelligence technologies 

are reporting, online analytical processing, analytics, data 

mining, process mining, complex event processing, 

business performance management, benchmarking, text 

mining, predictive analytics and prescriptive analytics

Copyright Dan Brandon, PhD, PMP
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Business Intelligence



Business Intelligence Skills

◼Database – SQL

◼Data Warehouse

◼Statistics

◼Analytics (quantitative methods)

◼OLAP

◼Data Mining

◼Data Visualization

◼Artificial Intelligence
Copyright Dan Brandon, PhD, PMP
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Top Tech Initiatives for 2015
[CIO Magazine Survey]

◼Business Intelligence (analytics)

◼Mobile Technologies

◼Cloud Services

◼Application Modernization

◼Customer Experience Technologies

◼Security and Risk Management

Copyright Dan Brandon



Data Analytics Jobs

Copyright Dan Brandon, PhD, PMP
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A report released in 2016 

by Glassdoor says that 

data scientists have the 

best jobs in the U.S., 

according to that 

company's analysis.

With a median base 

salary of $116,840, more 

than 1,700 job openings 

on Glassdoor's site, and 

a user-provided career 

opportunities rating of 

4.1, "data scientist" took 

the prize for most highly 

rated job title in 

America.



SQL
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Example Database Tables
[salesperson, product, sales]

◼S (SID, SName, City)

◼P (PID, PName, Size, Price)

◼SP (SID, PID, Qty)

Keys ?
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Salesperson Table (S)

SID Sname City
S1 Peterson Aarhus

S2 Olsen Copenhagen

S4 Hansen Odense

S5 Jensen Copenhagen
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Product Table (P)

PID PName Size Price
P1 Shirt 6 50

P3 Trousers 5 90

P4 Socks 7 20

P5 Blouse 6 50

P8 Blouse 8 60
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SP Table (Intersection Table)

SID PID Qty
S2 P1 200

S2 P3 100

S4 P5 200

S4 P8 100

S5 P1 50

S5 P3 500

S5 P4 800

S5 P5 500

S5 P8 100
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Access Exercise

◼1. Design each of three 

tables (S, P, SP), and set 

primary keys

◼2. Set up relationships 

(foreign keys)

◼3. Enter data



Don’t look ahead !



Access Model

Copyright Dan Brandon, PhD, PMP
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Access Relationship View
[establish “referential integrity”]

Copyright Dan Brandon, PhD, PMP
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Makes sure that the corresponding rows exists in S 

and P before adding entries to SP

Makes sure that entries in SP are deleted before 

deleting corresponding entries from S or P



Access “Query by Example”

◼Query-By-Example (QBE) is non-

procedural

◼There is no standard for QBE

◼Not all queries can be done in QBE

◼Create an Access QBE to answer this 

question:

◼ “In which cities are salespersons 

located ?”
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Don’t look ahead !
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Query Results

City

Aarhus

Copenhagen

Odense



Access Query Grid

Copyright Dan Brandon



Access Datasheet View

(Execute Query)

Copyright – Dan Brandon



SQL
[structured query language]

◼SQL is an international standard

◼Many more queries can be done in SQL 

than in QBE

◼Some queries can be done by one or 

more alternative methods in SQL

◼SQL is more efficient than QBE

◼SQL is used to interface to databases 

from programming languages

Copyright – Dan Brandon
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Retrieving Data via SQL

◼ SELECT columns-in-output-tables 

◼ FROM input-tables

◼ WHERE logical-expression

◼ ORDER BY columns -in-output-tables

◼ Output is always a table

◼ may be a table with only one row and/or 

column

◼ may be a NULL table



Access SQL View
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Relational Algebra PROJECTION
(“project” certain columns)

◼SELECT DISTINCT City

◼FROM S

◼ORDER BY City
◼ DISTINCT removes redundant columns*

◼ “In which cities are salespersons located ?”

◼ * In Access, select “Show Property Sheet” 

then; select “unique values” to “yes”



Query Properties
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Distinct & Distinctrow

◼In Access:

◼DISTINCT - Shows rows if 

selected columns are unique

◼DISTINCTROW - Shows rows if 

entire row from underlying 

table(s) are unique



Access Exercise

◼Perform an Access query via 

the query grid (QBE) to answer 

this question:

◼“List info for salespersons in 

Copenhagen”

◼What is the SQL for this query ?

Copyright Dan Brandon



Don’t look ahead !
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Query Results

SID Sname City

S2 Olsen Copenhagen

S5 Jensen Copenhagen



Copyright Dan Brandon

Relational Algebra SELECTION (WHERE)

(“select” certain rows)

◼ SELECT *

◼FROM S

◼WHERE City = ‘Copenhagen’

◼ORDER BY SName DESC

◼ “List info for salespersons in Copenhagen”

◼ * selects all columns

◼ DESC sorts in descending order



SQL “Join”

◼Multiply the two tables together (“cross 

join” - finds all combinations):

◼Combine every row of the first table 

with every row of the second table

◼ Eliminate the rows that do not match the 

join criteria

◼ Join criteria is usually a match between a 

foreign key in one table and the primary 

key in another table

Copyright – Dan Brandon



SQL Join (inner) on Vendor ID

Copyright – Dan Brandon

What about

Check 2 ?



SQL Join Query
[show salespersons (name and ID) and how much they have sold]

Copyright Dan Brandon, PhD, PMP
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Database → Spreadsheet

◼Data is often exported 

from data warehouses or 

databases into Excel or 

another analysis tool

◼Objects (such as queries) 

can be defined as the 

source of an export to 

Excel or other tool

Copyright – Dan Brandon



Export Database Object to Excel

[right click object]

Copyright – Dan Brandon



Or from ribbon:
External Data Tab, Export Group, Excel

Copyright – Dan Brandon



Export Database Object to Excel 

(con’t)

Copyright – Dan Brandon



Export Database Object to Excel 

(con’t)
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Export Database Object to Excel 

(con’t)
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Export Database Object to Excel 

(con’t)
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Data Mining
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◼What is the “scientific 

method” ?

Copyright – Dan Brandon



Don’t look ahead !



The “Scientific Method”

◼ Formulate a hypothesis

◼ Gather data:

◼ Experiments

◼ Surveys

◼ Observations

◼ Use inferential statistics 

to see if the data 

supports the hypothesis

Copyright – Dan Brandon



Wikipedia

◼ Data mining is the computational process of discovering 

patterns in large data sets involving methods at the 

intersection of artificial intelligence, machine learning, 

statistics, and database systems

◼ The overall goal of the data mining process is to extract 

information from a data set and transform it into an 

understandable structure for further use

◼ Aside from the raw analysis step, it involves database and 

data management aspects, data pre-processing, model 

and inference considerations, interestingness metrics, 

complexity considerations, post-processing of discovered 

structures, visualization, and online updating

Copyright Dan Brandon, PhD, PMP
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Data Mining Techniques

◼ Association or affinity analysis uses a specialized set of 
algorithms that sort through large data sets and 
express statistical rules among items

◼ Nearest-neighbor and clustering method

◼ Text mining and context analysis

◼ Neural computing is a machine learning approach 
which examines historical data for patterns

◼ Intelligent agents retrieving information from the 
Internet or from intranet-based databases

◼ Genetic algorithms



Purchase Information

◼ Purchase patterns of customers (transaction data) 

contain a huge wealth of information that many 

business now use for a variety of purposes:

◼ Marketing

◼ Up selling

◼ Cross selling

◼ Recommendations

◼ Inventory & logistics

◼ Store management

◼ This is often combined with shopper ID information



57

Affinity Analysis
[Market Basket Analysis]

◼ This is the most widely used and, in many ways, 
most successful data mining algorithm

◼ It essentially determines what products people 
purchase together

◼ Stores can use this information to place these 
products in the same area (particularly preferred 
brands)

◼ Direct marketers can use this information to 
determine which new products to offer to their 
current customers

◼ Inventory policies can be improved if reorder points 
reflect the demand for the complementary products
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Association Rules for 

Market Basket Analysis

Rules are derived in the form 

“left-hand side implies right-

hand side” and an example is:

Yellow Peppers IMPLIES Red 

Peppers, Bananas
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Unidirectional Rules

◼The rules are 
unidirectional

◼The following is an 
“obvious” rule:

◼Caviar IMPLIES Vodka

◼But the reverse is not 
true:

◼Vodka IMPLIES Caviar
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Measures of Predictive Ability
[“left-hand side implies right-hand side” ]

1. Support (prevalence) refers to the 
percentage of baskets where both left and 
right side products were present

2. Confidence measures what percentage of 
baskets that contained the left-hand product 
also contained the right

3. Lift measures how much more frequently the 
left-hand item is found with the right than 
pure chance (the product of their individual 
probabilities of occurrence)
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Example rule:

◼ Green Peppers IMPLIES Bananas

◼ Confidence – 85.96

◼ About 86% of the baskets with green peppers
also had bananas

◼ Support – 3.77

◼ About 4% of the baskets had both green peppers 
and bananas

◼ Lift – 1.37 

◼ It is 1.37 times more likely to find green peppers 
with bananas than the product of their individual 
probabilities (probability of green peppers AND 
bananas)



Example Analysis

◼ The confidence suggests people buying any kind of 
pepper also buy bananas

◼ Green peppers sell in about the same quantities as 
red or yellow (lift), but are not as predictive (support)

Rule:

Green 

Peppers 

IMPLIES

Bananas

Red Peppers 

IMPLIES

Bananas

Yellow 

Peppers 

IMPLIES

Bananas

Lift 1.37 1.43 1.17

Support 3.77 8.58 22.12

Confidence 85.96 89.47 73.09
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Market Basket Analysis Methodology

◼ We first need a list of transactions of what 

was purchased - this is readily available with 

electronic cash registers

◼ Next, we use a list of products to analyze, 

and tabulate how many times each was 

purchased with the others

◼ The diagonals of the table shows how often a 

product is purchased in any combination, and 

the off-diagonals show which combinations 

were bought
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A Small Simple Store Example

Consider the following simple 
example about five transactions 
at a convenience store:

Transaction 1:  Frozen pizza, cola, milk

Transaction 2:  Milk, potato chips

Transaction 3:  Cola, frozen pizza

Transaction 4:  Milk, pretzels

Transaction 5:  Cola, pretzels



Cross Tabulation in a Table

◼ Pizza and Cola sell together more often than any 
other combo; a cross-marketing opportunity?

◼ Milk sells well with everything – people probably 
come here specifically to buy it

Product 

Bought

Pizza 

also

Milk

also

Cola 

also

Chips 

also

Pretzels

also

Pizza 2 1 2 0 0

Milk 1 3 1 1 1

Cola 2 1 3 0 1

Chips 0 1 0 1 0

Pretzels 0 1 1 0 2



Market Basket Concepts

◼ Transaction – the purchase of one or more 

items by a customer at one point in time and 

space – a “shopping cart” or “market basket”

◼ Association Rule – a rule which suggests a 

relationship between items in the transaction, 

written as for single items A and B:

◼ A IMPLIES B    (or A → B)



Support

◼ Support – the % of transactions (baskets) 
where an association rule applies –
where we see both item A and B in the 
same basket

◼ For example, if 500 baskets contain 
both A and B out of a total of 1000 
baskets, then the support is 50%

◼ A→B and B→A both have the same 
support



Confidence

◼ Confidence – measures the predictive accuracy of a 

rule

◼ Confidence is the probability that item B is in the 

basket if item A is in the basket (“conditional 

probability”) → P(B|A) = P(AB)/P(A)

◼ Calculated as:

◼ Support (A & B)/P(A) where support (A) is the % of 

baskets containing A

◼ For example, if 500 baskets contain both A and B out of a 

total of 1000 baskets, then the support of A & B is 50%

◼ If A is in 75% of baskets, the confidence is  50/75 or 67%



Lift

◼ Lift - the ratio of support to a product to the 

individual probabilities of both sides

◼ P(AB)/(P(A) * P(B))

◼ For example:

◼ For example, if 500 baskets contain both A 

and B out of a total of 1000 baskets, then the 

support of A & B is 50%

◼ If A is in 75% of baskets and B is in 20% of the 

baskets, then the lift is:

◼ .50/(.75*.20) = 3.33



Computing Support

Pizza Milk Cola Chips Pretzels

Pizza 2 1 2 0 0

Milk 1 3 1 1 1

Cola 2 1 3 0 1

Chips 0 1 0 1 0

Pretzels 0 1 1 0 2

The support measure for Cola IMPLIES Pizza is 

40% (2/5).

Of the 5 transactions 2 have both cola and pizza.

Note support does not consider direction (Pizza 

IMPLIES Cola is also 40%).



Computing Confidence

Pizza Milk Cola Chips Pretzels

Pizza 2 1 2 0 0

Milk 1 3 1 1 1

Cola 2 1 3 0 1

Chips 0 1 0 1 0

Pretzels 0 1 1 0 2

Milk IMPLIES Chips has a confidence of 33%, 

since the support of “Milk plus Chips” is 20% (1/5) 

and Milk is in 60% of baskets (3/5).

Thus 20%/60% is 33. Confidence is unidirectional ! 



Computing Lift

Pizza Milk Cola Chips Pretzels

Pizza 2 1 2 0 0

Milk 1 3 1 1 1

Cola 2 1 3 0 1

Chips 0 1 0 1 0

Pretzels 0 1 1 0 2

Lift is the ratio of support of a product to the 

individual joint probabilities of both sides.

Cola IMPLIES Pizza lift is .40/(.60 * .40) = 1.67.
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Using the Results

◼ The tabulations can immediately be 

translated into association rules and the 

numerical measures computed

◼ Comparing this week’s table to last week’s 

table can immediately show the effect of this 

week’s promotional activities

◼ Some rules are going to be trivial (hot dogs 

and buns sell together) or inexplicable (toilet 

rings sell only when a new hardware store is 

opened)



Market Basket Illustration Tool

Copyright – Dan Brandon



Example Database

Star Schema



Example Access Data



Transaction Example Data



SQL “Baskets” View
[SELECT Transactions.TransID, UPC.ItemName AS Item

FROM UPC INNER JOIN Transactions ON UPC.UPC=Transactions.UPC;]

Might have many UPC’s

for same product,

such as different sizes.



Cross Product to Find Products Selling Together
[each row in the first table combined with each row in the second table]



SQL “Pairs” View (same basket [transaction])
[SELECT T1.Item AS Item1, T2.Item AS Item2

FROM Baskets AS T1, Baskets AS T2

WHERE T1.transID=T2.transID And T1.Item<>T2.Item;]



SQL Transaction Count

◼ Standard SQL

◼ SELECT count(DISTINCT TransID) AS 

TransCount

FROM Baskets

◼ Access SQL

◼ SELECT count(*) AS TransCount

FROM (SELECT DISTINCT TransID FROM 

baskets)



SQL Grouping View

◼ SELECT Item, count(*) AS ItemCount

◼ FROM Baskets

◼ GROUP BY Item;



SQL Support Count

◼ From the transactions, how many are for each 

pair:

◼ SELECT Item1, Item2, count(*) AS 

SupportCount

◼ FROM Pairs

◼ GROUP BY Item1, Item2;



SQL Support

◼ From the transactions, how many are for 

each pair as a percentage of the total 

transactions:

◼ SELECT Item1, Item2, count(*) AS 

SupportCount, count(*)/(SELECT count(*) AS 

TransCount FROM (SELECT DISTINCT 

transID FROM transactions)) AS Support

◼ FROM Pairs

◼ GROUP BY Item1, Item2;



Support (con’t)

Cola IMPLIES Pizza support is 40%; of the 5 transactions, 2 have both 

Cola and Pizza. 

Pizza IMPLIES Cola is also 40% (support does not consider direction)



SQL Confidence

◼ Support divided by % of baskets containing the 
first product in the rule

◼ SELECT Item1, Item2, count(*) AS SupportCount, 
count(*)/(SELECT count(*) AS TransCount FROM 
(SELECT DISTINCT transID FROM baskets)) AS 
Support, (select count(*) from baskets where 
Item=Item1)/(SELECT count(*) AS TransCount
FROM (SELECT DISTINCT transID FROM 
baskets)) AS Item1inBaskets, 
Support/Item1inBaskets AS Confidence

◼ FROM Pairs

◼ GROUP BY Item1, Item2;



Confidence (con’t)

Milk IMPLIES Chips has a confidence of .33  [.2 divided by .6]

Chips IMPLIES Milk has a confidence of 1



SQL Lift
◼ Lift is the ratio of support to the product of the individual 

probabilities
◼ SELECT Item1, Item2, count(*) AS SupportCount, 

count(*)/(SELECT count(*) AS TransCount FROM (SELECT 
DISTINCT transID FROM baskets)) AS Support, (select 
count(*) from baskets where Item=Item1)/(SELECT count(*) 
AS TransCount FROM (SELECT DISTINCT transID FROM 
baskets)) AS Item1inBaskets, Support/Item1inBaskets AS 
Confidence, (select count(*) from baskets where 
Item=Item2)/(SELECT count(*) AS TransCount FROM 
(SELECT DISTINCT transID FROM baskets)) AS 
Item2inBaskets, Support/(Item1inBaskets*Item2inBaskets) 
AS Lift

◼ FROM Pairs

◼ GROUP BY Item1, Item2;



Lift (con’t)

The lift for the rule “Cola IMPLIES Pizza” is .4/ (.6 * .4) = 1.67



Selecting Rules → “Mining”

◼ To select the relevant rules, one would select 

rows from the previous table where the support, 

confidence, and lift met minimum criteria

◼ SELECT Item1, Item2, Support, Confidence, Lift

◼ FROM [Support-Confidence-Lift]

◼ WHERE Support>=0.4 AND Confidence>=1 

AND Lift>=1;
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Performing Analysis with Virtual 

Items

◼ The sales data can be augmented with the 

addition of “virtual items” -- For example, we 

could record that the customer was new to us, 

or had children

◼ The transaction record might look like:

Item 1: Sweater       Item 2: Jacket       Item 3: New

◼ This might allow us to see what patterns new 

customers have versus old customers
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Multidimensional Market 

Basket Analysis

◼ Rules can involve more than two items, for 
example Plant and Clay Pot IMPLIES Soil

◼ These rules are built iteratively -- first, pairs are 
found, then relevant sets of three or four

◼ In our example here, one would join the “pairs” 
table to itself, to formulate a “triples” table

◼ These are then pruned by removing those that 
occur infrequently

◼ In an environment like a grocery store, where 
customers commonly buy over 100 items, rules 
could involve as many as 10 items



Online Analytical 

Processing

93
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Traditional SQL Queries

◼ User requests are stated in a query language and the results are 
subsets of the data in the relational tables:

◼ Sales by department by customer type for specific period

◼ Weather conditions for specific date

◼ Sales by day of week

◼ …

Queries allow users to request information from the 
computer that is not available in periodic reports

Query systems are often based on menu/GUI based 
programs (which generate SQL) or via direct 
structured query language (SQL) or using a query-
by-example (QBE) method



Wikipedia

◼ In computing, online analytical processing, 

or OLAP, is an approach to answering multi-

dimensional analytical queries swiftly

◼ OLAP tools enable users to analyze 

multidimensional data interactively from 

multiple perspectives

◼ OLAP consists of three basic analytical 

operations: consolidation (roll-up), drill-down, 

and slicing and dicing

Copyright Dan Brandon, PhD, PMP

95



96

OLAP

◼ On Line Analytical Processing (OLAP) is a 
relatively new way of storing, viewing, and 
presenting information

◼ With it, data is viewed in cubes

◼ A two dimensional cube can be viewed as a 
table

◼ A three dimensional cube as a “cube”

◼ A multidimensional cube as a “hypercube”

◼ These cubes have axes, dimensions, 
measures, slices, and levels



Example: Relational Source Data

What is the average sales price for new single 

family homes in LA in the 2QT of 2001 ?



Example: OLAP Cube for Average Sales Price
[2 “axes” (rows and columns): date “dimensions” and type “dimensions”]

What is the average sales price for new single family homes in LA in the 2QT of 2001 ?
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OLAP (con’t)

◼ When 2 or more dimensions are shown on 

one axis, then every combination (relational 

column) of one must be shown with the other

◼ Notice the same sub categories under both 

existing and new construction categories, and 

same categories under 2000 and 2001

◼ The cells of the OLAP cube hold the 

“measures” (the data); here the measure is 

sales price for single family homes 
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OLAP Slices

◼ This OLAP cube is just for the 

average sales price of single 

family homes; there would be 

another cube for the average 

sales price of condos

◼ You could think of these two 

cubes as one behind the other, 

or as “slices”

◼ We could also have slices for 

“sales price” and “asking price”
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“Members” and “Levels”

◼ The values of a dimension are 
called “members”

◼ The members of the type 
dimension are single and condo

◼ The members of the category 
dimension are new and existing

◼ For this data set, the members of 
the state dimension are CA an NV

◼ Some members may be computed 
such as date and/or time

◼ The “level” of a dimension is its 
position in the hierarchy; the levels 
of the date dimension are year, 
quarter, and month



OLAP Terminology

◼ OLAP hypercube: means a data display with an 
unlimited number of axes



OLAP Cube Data Definition
[4 dimensions, 2 slices (sales and asking price)]

CREATE CUBE HousingSalesCube (

DIMENSION Time TYPE TIME,

LEVEL Year TYPE YEAR,

LEVEL Quarter TYPE QUARTER,

LEVEL Month TYPE MONTH,

DIMENSION Location,

LEVEL USA TYPE ALL,

LEVEL State,

LEVEL City,

DIMENSION HousingCategory,

DIMENSION HousingType,

MEASURE SalesPrice,

FUNCTION AVG

MEASURE AskingPrice, 

FUNCTION AVG

)

Compare to SQL Data Definition Language: “create table”
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Multidimensional SELECT Statement

[produces this “view”]

SELECT CROSSJOIN 

({Existing Structure, New 
Construction},

{California.Children, Nevada})

ON COLUMNS,

{2000.Q1.Children, 2000.Q2, 
2000.Q3, 2000.Q4,

2001.Q1.Children, 2001.Q2, 2001.Q3, 
2001.Q4}

ON ROWS

FROM HousingSalesCube

WHERE (SalesPrice, HousingType = 
‘SingleFamily’)

The OLAP “crossjoin” ({X,Y}, {A,B}) 

creates a view

where X and Y are the main 

categories

A and B are sub categories 

under both X and Y

Crossjoins are created on the 

columns or rows
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Related Tables

◼ The previous example only had one relational 

table

◼ Most databases have multiple tables with 

primary/foreign key relationships

◼ Often the dimensions are held as foreign 

keys in the “cube” table, with relations to 

other tables (“member data”) with the details 

about each dimension
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Example: Star Schema



Example: Snowflake Schema



MOLAP & ROLAP

◼ OLAP servers typically come in two basic flavors

◼ Some servers have specialized data stores which store data in a form 

which is highly effective for multidimensional analysis

◼ These servers are termed MOLAP and they tend to have exceptional 

performance due to their specialized data store

◼ Loading data into a MOLAP server usually takes a very long time 

because many of the answers in the cube must be calculated (the extra 

time spent during the load is usually called “processing” time)

◼ A relational OLAP (or ROLAP) server uses data stored in an RDBMS

◼ These systems trade the performance of a multidimensional store for 

the convenience of an RDBMS. These servers almost always query 

over a database which is structured as a star or snowflake type 

schema. 

◼ An OLAP server usually returns information to the user as a ‘pivot table‘ 

or ‘pivot report’ which are now supported in both Excel and Access

Copyright Dan Brandon, PhD, PMP
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Pivot Table
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Microsoft OLAP Architecture



TN OLAP Application
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http://www.youtube.com/watch?v=-j5J7lXav7Y


OLAP Vendors

◼ SQL Server

◼ Oracle

◼ IBM

◼ SAS

◼ Teradata

◼ 1010 Data

◼ Information Builders

◼ Open Source (interface to MySQL), such as 

Mondrian

Copyright Dan Brandon, PhD, PMP
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Earlier Access Model

Copyright Dan Brandon, PhD, PMP
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How many shirts have been sold ?

How many items has Jensen sold ?

How many items have been sold in 

Copenhagen ?



Pivot Table (OLAP) View

Copyright – Dan Brandon



Access Pivot Table

Copyright Dan Brandon, PhD, PMP
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How many shirts have been sold ?

How many items has Jensen sold ?

How many items have been sold in Copenhagen ?
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Project 5
◼ Create an OLAP model (pivot table) for the 

Access S-P-SP problem with one dimension for 
products (by name) and the other dimension for 
city/salesperson (by name)  – use the quantity as 
the measure (metric)
◼ Note: Microsoft Access (not SQLServer) dropped pivot 

tables starting with Office 2013 – need to export query 
to Excel and use Excel pivot table, or use new Get & 
Transform tools in Excel→



Excel Traditional Pivot Table
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Excel OLAP (Data Models)

◼ Latest versions of Excel have “Get & Transform” which 

can import directly from relational databases such as 

Access, SQLServer, MySQL, Oracle, etc.

◼ Import can be to a table to build a traditional pivot 

table) , data model (Power PivotTable), or PivotChart

◼ Tables and relationships can be imported
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Data Models (con’t)

◼ Example Access database:
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Data Models (con’t)

◼ Open a new Excel workbook, then:

◼ Data → Get & Transform → Get Data → From

Database → from Microsoft Access Database

Copyright Dan Brandon, PhD, PMP
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Data Models (con’t)

◼ From Microsoft Access Database then chose 

database file in Windows file selection window

Copyright Dan Brandon, PhD, PMP
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Data Models (con’t)

◼ Navigator window opens – select multiple 

items – click load button
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Data Models (con’t)

◼ Click Load → Load To …

◼ Click Pivot Table Report (Add this to the Data 

Model is automatically checked)

◼ Click OK
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Data Models (con’t)

◼ An empty OLPA pivot table is created, and 

you can now design your pivot table
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Data Models (con’t)

◼ Qty by Salesperson name and Product name
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Data Models (con’t)

◼ One can see the imported Data Model:
◼ Power Pivot → Data Model → Manage

◼ The Power Pivot window opens

◼ Home → View → Diagram View
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